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Voltage Fusion Release Notes
Software version: 23.2.0

Publication date: June 2023

This document is an overview of the changes made to Voltage Fusion.

Support matrix
For information about the installation requirements and compatibility with other products, see the
Voltage Fusion Support Matrix. The support matrix may be updated between releases so it is
available only from the Support portal.

About Voltage Fusion
Voltage Fusion lets you find, protect, and secure sensitive and high-value data within on-premises
and cloud data platforms across your enterprise. Identify, collect, and organize content to ensure
discovery of sensitive data. Configure how structured and unstructured sources and datasets are
processed and categorized with Connect. Analyze your data under management with Analyze.
Organize, review, and take action on unstructured data items with Manage.
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What's new in 23.2.0
The following features and enhancements are included in this release.

General
The following features and enhancements apply to more than one component in Fusion.

l Updated the product name from File Analysis Suite to Voltage Fusion, as well as updated
company branding.

Voltage Fusion is the new product name for the file and database analysis solution. A "fusion" of
unstructured and structured data analysis and management from the same platform.

l Updated the product version number structure. The new numbering structure represents the
year and quarter of the release.

l Added support for managing structured data through connection to Structured Data Manager.
When processing structured data, data is processed as it relates to tables and is processed in
place. Content is not stored in Fusion; only metadata is added to the Fusion index.
o You create structured data sources and then inventory them to identify tables and views

present in the sources. You then create datasets to select the tables to process to identify
the presence of sensitive information.

o Added "Enable structured data capabilities" option to the agent cluster options in Connect.
When creating a structured data source, you can only assign agent clusters that are
enabled for structured data capabilities.

o Added a Structured Data tab to the Data Volume dashboard in Connect. View the total
volume of all structured data tables and analyzed tables over time. For more information,
see "Data Volume" in the Connect Help Center.

o Added an Analyzed Sensitive Data dashboard for structured data to Analyze. For more
information, see Analyze, on page 5 and "Unstructured data dashboards" in the Analyze
Help Center.

o Added "Structured Data" filter criterion to the filter panel in Analyze to filter the results by
whether the data is structured or unstructured.

o Added "Is Structured Data?" criterion to the query builder for searches in Analyze, for tag
criteria in Connect.

o When viewing a structured data table in Analyze, you will not see the content view panel.
On the Data Analysis tab of the detail panel, view the columns in which sensitive data has
been identified. Expand the column names to view the grammar rule that identified the
sensitive data. On the Metadata tab of the detail panel, view the metadata related to the
selected table.
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o Added the Column, Column Count, and Row Count fields to the CSV export options in
Analyze. Renamed the File Path field to Path and the Subject/Title field to Title to the CSV
export options in Analyze and Manage.

o Added an icon for structured data in Analyze. The structured data/table icon ( ) displays in
the data list.

For details about configuring the structured data connection, see "Structured data connection"
in the Connect Help Center.

NOTE: Structured data cannot be added to workspaces in Manage.

l Added the following metadata fields. These fields are now available in the search builder in
Analyze and Manage, as well as in the dataset primary capture rules and tag creation in
Connect.
o Content Manager Record Number, Record Extended Number, and Record Note
o First Processed Date
o Last Processed Date
o First Analyzed Date
o Last Analyzed Date

l Added the following metadata fields. These fields are now available in the search builder in
Analyze and Manage.
o Content Manager Classification and Record Type

Processing Agent
The following features and enhancements apply specifically to the processing agent.

l Added context to processing errors generated outside of Fusion, such as from SharePoint, to
provide more detail.

l Now support processing data from Content Manager 10.1.

Connect
The following features and enhancements apply specifically to Connect, and are in addition to
changes already mentioned in relation to general enhancements.

l Renamed the "repository" data structure to "dataset".

l Enhanced the information provided for Agent Activity. For more information, see "Agent
management > Agent activity" in the Connect Help Center.
o Expanded and clarified the information available directly in the agent activity list.
o Added a detail panel to the agent activity. You can now expand the agent activity detail

panel to view in-depth information about the selected activity. When applicable, you can see

Release Notes
What's new in 23.2.0

Fusion (23.2.0) Page 3 of 13



the status of the individual tasks that make up the activity.

For activities other than Inventory, click VIEW CONTENTS to go to the Research page in
Analyze to view the list of documents against which the activity was performed.

o For activities that completed with errors, the status has been clarified to specify whether the
error was related to ingestion or to processing.

n Completed with ingestion errors indicates that the agent run has completed
indexing, but errors occurred. For example, if an agent fails to download an item while
scanning a dataset.

TIP: In this scenario, you can go to the dataset and initiate another scan.

n Completed with processing errors indicates that the agent run has completed
processing, but errors occurred. For example, the item has been successfully added to
the index but the requested action (such as text extraction) cannot be taken.

n Completed with errors indicates that the agent run has completed, but both ingestion
and processing errors occurred.

o For activities that completed with errors, view the error message and workunit information.
You can use the workunit ID and the time stamp to assist in locating the appropriate log file
and error the agent identified. Click the copy icon to copy the error message to use as
needed.

o From the agent activity list, click a source (structured data) or dataset (unstructured data)
name to go to the Manage Sources or Manage Datasets page with the source or dataset
highlighted and the detail panel open. Click an agent cluster name to go to the Agent
Clusters page with the cluster highlighted and the detail panel open. For an activity that
completed with errors, click the "completed with errors" link to view the activity error details.

o In the agent activity list, workbook activities that span multiple datasets are grouped
together. Expand the workbook activity to view the activities for each dataset involved.
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l Updated the icon to represent cloud processing agents and agent clusters as shown in the
agent activity list and the agent cluster list. The new icon ( ) lets you more easily differentiate
between on-premises and cloud agents and clusters.

l Added the Fusion grammar rule ID to the grammar rule detail panel. This information can be
used when creating custom grammar rules that are applied to structured data datasets.

l To track items deleted in Content Manager and report on them in the Fusion audit log, the
"Record Disposition Changed" audit event type must also be selected in Content Manager. For
full details, see "Integrations > Content Manager integration > Enable delete tracking" in the
Connect Help Center.

l Updated grammars.
o The Identification Data > Name grammar has been improved when matching names where

the surname occurs first, for example "Smith, Peter John". Improvements have also been
named when matching titles in names. For example, "King Street" would no longer be
matched as a name.

o The Financial Data > IBAN (International Bank Account Number) grammar has been
updated with the following additional countries: Andorra (AD), Azerbaijan (AZ), Georgia
(GE), Gibraltar (GI), Holy See (VA), Iraq (IQ), Jordan (JO), Kosovo (XK), Lebanon (LB),
Libya (LY), Mauritania (MR), Mauritius (MU), Palestine (PS), Qatar (QA), Saint Lucia (LC),
Sao Tome and Principe (ST), Seychelles (SC), Sudan (SD), Timor-Leste (TL), Tunisia (TN),
Virgin Islands British (VG).

In addition, entities have been added for the Faroe Islands (FO). These patterns were
previously incorrectly matched by the Denmark (DK) entities.

o The Financial Data > Sort Codes grammar for Ireland (IE) has been adjusted to better
match a known sort codes.

Analyze
The following features and enhancements apply specifically to Analyze, and are in addition to
changes already mentioned in relation to general enhancements.

l New dashboards available in Analyze.
o The Risk Analysis Overview dashboard depicts the potential risk exposure associated with

your unstructured and structured data under management. Potentially sensitive data is
identified by the weighted labels that are applied as the data is analyzed.

Release Notes
What's new in 23.2.0

Fusion (23.2.0) Page 5 of 13



Click any data segment in a chart to go to the Research data list page and see the list of
items that segment represents.

For more information, see "Overview Analysis > Risk Analysis Overview" in the Analyze
Help Center.

o The Financial Risk Modeler lets you assess the true cost of data privacy. The modeler is
based on the "Cost of a Data Breach" by Ponemon Institute and the Information Risk
Insights Study (IRIS 20/20), by Cyentia Institute.

Get a personalized financial risk model by modifying the default values with information
about your company and data environment. You can use the information from the
dashboards to provide responses that reflect your current data under management.

For more information, see "Overview Analysis > Financial Risk Modeler" in the Analyze
Help Center.

o The Analyzed Sensitive Data dashboard for structured data depicts the distribution of
sensitive data in databases under management. Sensitive data is identified by the weighted
labels that are applied as metadata and content are analyzed.
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l Updated all other unstructured data dashboards to show "dataset" or "source" information
instead of "repository" information.

For more information, see "Unstructured data dashboards" in the Analyze Help Center.

l Updated the Sensitive Trend Analysis dashboard to show the grammar types found instead of
the grammar rules. The grammar types are groupings of grammar rules that share a similar
pattern. For example, Fusion now shows the built-in "Addresses" grammar type instead of the
multiple grammar rules that identify the mailing address patterns individual countries.

l Updated column headings and labels in Research to better represent the information that now
includes both structured and unstructured data values.

Manage
The following features and enhancements apply specifically to Manage, and are in addition to
changes already mentioned in relation to general enhancements.

l Removed the concept of a "data source" within a workspace. You now directly select the
datasets (formerly known as repositories) to include in a workspace.
o When creating a workspace, select the datasets to include. You can filter the available

datasets by Sources, Types, and Clusters.
o Legacy datasets (data sources from previous releases) are not available for selection when

creating a new workspace.
o Removed data source templates.

l Workbook actions are executed against individual documents (families) rather than the items.
The workbook list now includes documents instead of items. You can view the contents of
container documents in the content view.
o For previously created workbooks that were executed against individual items, a warning

icon ( ) displays next to the workbook name in the detail panel indicating that the format
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has changed. Hover over the warning icon to learn more and, if necessary, how to update
the workbook.

When exporting documents from a workbook, removed the Export top-level documents only
option.

l Added a DRAFT state to workspaces. When you create a workspace, the workspace enters a
draft state. You can edit all workspace details while the workspace has a DRAFT status. Once
you have fully defined the desired details, you can change the workspace status to OPEN and
perform file analysis and actions on data in the workspace.

NOTE: Datasets can be added or removed from a workspace while the workspace is in
DRAFT. Once OPEN, datasets can be added to the workspace, but not removed.

l Added more filter options to the workspace list page. You can now filter workspaces by Draft
Workspaces,Open Workspaces, Closed Workspaces, Awaiting Review, or All Statuses.

l When creating a workspace or workspace template you can specify whether to limit items
added to workspaces by data subject.
o Select Match all data related to workspace data subjects to only add data that is

associated with the data subjects assigned to the workspace for the selected datasets and
matching the workspace criteria. Data is not added to the workspace until data subjects are
assigned. Data manually added from Research in Analyze can be added, regardless of data
subject assignment.

o Select All data including data with no data subject to add all data from the selected
datasets and matching the workspace criteria, even data items that are not associated with
any data subjects.

l Updated the Map view of the individual workspace overview. If you add grammars to the view,
the map now shows grammar types found instead of the grammar rules. The grammar types
are groupings of grammar rules that share a similar pattern. For example, Fusion now shows
the built-in "Addresses" grammar type instead of the multiple grammar rules that identify the
mailing address patterns individual countries.

l Added a detail panel for the workbook template page.

Administration
The following features and enhancements apply specifically to Administration, and are in addition to
changes already mentioned in relation to general enhancements.

l None

API updates
The following updates have been made to the Fusion APIs.

l With the removal of the data source concept, all methods related to data source templates have
been removed. These removed methods began with /ca/v1/datasource-template.

Release Notes
What's new in 23.2.0

Fusion (23.2.0) Page 8 of 13



l With the removal of the data source concept, the create datasource method, POST
/ca/v1/workspace/{workspaceId}/datasource, has been removed.

l With the removal of the data source concept, the update datasource method, PUT
/ca/v1/workspace/{workspaceId}/datasource/{datasourceId}, is now only used to update
the name and description of Research and Legacy datasets.

When creating a workspace there is a new payload property, primaryDatasets. This has the
same structure as the old data source and allows you to define the datasets and criteria that you
want.

Example: create one Exchange dataset, two file system datasets, one Content Manager
dataset, and one Google Drive dataset.

{
"primaryDatasets": {
"dataSubjectDataOnly": false,
"startDate": 1612195007007,
"endDate": 1673539019849,
"exchangeDetails": {
"repositoryIds": [
184544

]
},
"contentManagerDetails": {
"classifications": [
"clsf"

],
"recordTypes": [
"rt"

],
"repositoryIds": [
184541

]
},
"fileSystemDetails": {
"extensions": [
"txt"

],
"repositoryIds": [
184256,
184323

]
},
"googleDriveDetails": {
"extensions": [
"xlsx"

],
"repositoryIds": [
186476
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]
}

}
}

The primaryDatasets object is not saved into the workspace object. Instead it creates a
separate workspace dataset object for each dataset ID you specify.

When you want to update an existing workspace you can again use the primaryDatasets
structure to do the update. Any dataset ID that was not there previously will be created. Any
dataset ID that is not there now will be deleted. Any other dataset IDs will be updated.

Do not use this structure to delete Research or Legacy datasets (previous data sources). If you
want to remove a Research or Legacy dataset, use the customDatasetsToRemove array (of
longs) to specify the workspace dataset IDs (not the actual dataset ID) being removed.
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Resolved issues in 23.2.0
The following issues have been resolved in this release of Fusion.

l Resolved an issue where updates to some grammar sets did not recognize updates to grammar
rules. In this scenario, you will see a "Re-analyze" link next to the Grammar Sets label on the
detail tab for affected datasets (formerly known as repositories).

NOTE: The "Re-analyze" link displays for additional reasons as well.

l Resolved an issue where, creating a workspace from Analyze > Research could result in an
invalid workspace preventing tagging operations from succeeding

l Resolved an issue where, in some scenarios, the NEXT button on the Credentials page of the
dataset (formerly repository) creation wizard was dimmed and could not be clicked to move
forward.

l Resolved an issue where, in some scenarios, the specified file extensions defined as part of the
tag criteria were not saved.

l Resolved an issue where, in some instances, the contextual content of an .emz file
(compressed metadata file) associated with a message file with an embedded image was
incorrectly processed as an attachment to that message file.
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Known issues in 23.2.0
The following issues are present in this release of Fusion.

l Fusion does not support Content Manager VMBX files. All VMBX files must be converted to
EML or MSG prior to starting any processing by Fusion. VMBX files were supported by previous
versions of Content Manager.

l When creating Google Drive datasets for Shared Drives, the member account that is used to
access the drive must be unique for each dataset within a given Google Drive source. This
limitation will be addressed in a future release.

l Performing OCR from a workbook is not supported for items processed from an Exchange
repository. This will be addressed in a future release.

l To allow OCR for a given repository, the agent cluster to which the repository's source is
assigned must have OCR enabled and the dataset must have Store content as text enabled.

l If any of the Structured Data Processor certificate configuration information defined in the Agent
Administration UI is incorrect, an info-level message is logged every 5 seconds in the
StructuredDataProcessor.log file.

l If the Structured Data Processor base path defined in the Agent Administration UI is incorrect, a
message is not logged n the StructuredDataProcessor.log file.

l The creation of a deduplication task workbook currently places only the "head" of a document
family into the workbook instead of all members of the family.
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Documentation
Voltage Fusion includes Help Centers that are incorporated into each User Interface and are updated
with each software release as appropriate.

To view the Fusion documentation outside of the product, visit Support & Services on the Micro
Focus web site, www.microfocus.com.

To navigate to the Fusion documentation

1. From the Micro Focus home page click Support & Services in the primary menu along the top
of the page and then click Support.

2. In the Browse Resources section, click Documentation.

3. In the product selection list, begin typing Voltage Fusion. As you type, matching product
names display; click Voltage Fusion (formerly File Analysis Suite, FAS).

Select the desired release version.

You must have Adobe® Reader installed to view files in PDF format (*.pdf). To download Adobe
Reader, go to the Adobe web site.
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